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Getting Started with InDesign
Adobe InDesign is a very powerful publishing application.  In fact, 
many of the of books, magazines, pamphlets, brochures, PDF files, 
and fliers you read every day were created and published using 
InDesign.  InDesign is part of the Adobe Creative Suite 3 suite of 
applications that include Acrobat, Photoshop, Dreamweaver, Flash, 
Illustrator, and more.  If you don’t have access to these applications, 
you can download a trial version from the Adobe website...

Link:  http://www.adobe.com/products/InDesign/?promoid=BPDEI

Also, you’ll find links to video tutorials, a tour of the product, other 
downloads related to InDesign there. 

When you open InDesign, you’ll see a layout similar to that in the 
illustration above.  At the left is the toolbar.  As you select a tool by 
clicking on it, an options bar for that tool appears just under the 
menus at the top of the screen.  Above, I have the selection tool 
selected, and you see the common tasks and options I can do with 
that tool in the options bar at the top of the screen.  

On the right side of the screen, you see InDesign’s palettes (col-
lapsed so they take up little screen real estate).  Clicking on any pal-
ette will expand it.  For example, in the illustration to the right, I’ve 
clicked on the Pages palette.  It expanded to show me the pages 
in my document, which has twelve pages.  Double click any of the 
page thumbnails to go to that page.  Drag a page to the trash icon 
at the bottom of the palette to delete it.  Add a new page after the 
currently selected page in the palette by clicking on the  ‘Create 

New Page’ icon.  Duplicate a page by dragging its thumbnail icon 
on top of the ‘Create New Page’ icon.  (That’s the icon of a page 
with its corner turned up.)  Above the page thumbnails there’s a di-
viding line, above which you’ll see the master page icons.  Remem-
ber this, we’ll be talking about master pages later on.

In the center of the screen, you see the work area, or pasteboard.  
The Pasteboard includes your page layout, plus room around the 
outside to store objects that you may want to add onto the page 
later.  It is an intuitive, clean layout that corresponds closely to the 
layout of other Adobe applications.

http://www.adobe.com/products/InDesign/?promoid=BPDEI
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Preliminary Preparations Before Beginning an InDesign 
Project.  
When you start any InDesign project, you should first create a new 
folder on your hard drive and give it a name.  All resources you 
are going to include in your InDesign document should be saved 
to this folder, including any graphics and multimedia files.  This 
should be done before you actually insert any of these into your 
InDesign project.   Here’s why...

In order to save room in the InDesign file itself, InDesign creates a 
‘preview’ of any graphic or multimedia file you place in the docu-
ment - a low resolution placeholder instead of the real graphic.  
Imagine, if you will, that you have a 24 page document with a 
photo on each page.  High resolution color photos typically are 20 
megabytes in size (or higher!).  WIth 24 such photos, your InDesign 
document would end up being a huge, unwieldy file if it saved 
these photos as part of the file itself.  To get around this, and make 
InDesign more responsive to work with, low resolution previews 
are placed instead.  This allows you to visually view the layout 
you’re creating, but at the same time keeps things from bogging 
down in bloat.

When you actually create your new InDesign file for your project, 
that file should be saved into the folder you’ve created as well.  
Then if you have to move your project (say, to another computer), 
you just move the entire folder and its contents.  You’ll also want to 
make sure that other computer has the same fonts installed that 
you used in your project.   If you’re missing anything, InDesign will 
tell you.  The Links palette will help you reconnect things if you 
need to.

Create a New File in InDesign
By default, InDesign uses points or picas to measure things on a 
page.  These are common measurement systems for printers and 
publishers - but confusing to most of us who are used to the good 
old English measurement system of inches.  A pica is a typesetting 
unit of measurement commonly used for measuring lines of type. 
One pica equals 12 points. There are 6 picas to an inch. Also used 
to describe a typewriter type that prints 10 characters per inch 
(cpi).  It takes 72 points to make an inch.  You’ve worked with points 
before - every time you change a font size.  Fonts are measured in 
points.  

You usually change the measurement system by going into the 
preferences - units and increments - and change it to inches.  You 
can also right-click on the ruler in InDesign and choose inches to 
display on the ruler. 

“What you may not know is that you can also change the global 
measurement system on the fly without ever going into the Units & 
Increments pane of Preferences.

It’s a keyboard shortcut—four-fingered, true, but still typically fast-
er than the Preferences route. On Mac, press CMD+OPT+SHIFT+U, 
and on Windows, CTRL+ALT+SHIFT+U, to cycle through the avail-
able measurement systems, in the order of the Units & Increments 
Ruler Units menus—Points, Picas, Inches, Inches Decimal, Millime-
ters, Centimeters, Ciceros, and Custom (measured in points). Each 
press of the keyboard shortcut will change both the horizontal 
and vertical rulers, as well as reflect in the applicable fields on the 

Transform, Control, and other palettes.”  (http://www.InDesignsecrets.com/

change-measurement-systems-on-the-fly.php)

So after you’ve changed the measurement system to your particu-
lar preference, click the File - New - Document menu, and you’ll see 
the following dialog...

Here, you can specify the number of pages.  If you’re creating a 
book with facing pages that need extra room at one edge for bind-
ing purposes, you’ll want to make sure the facing pages option is 
checked.  That way, you’ll end up with 2-page spreads.  You can 
choose the margin sizes, number of columns, and paper size as 
well.  Once you click OK, you’ll be looking at a similar screen layout 
that I showed you on the previous page.  Let’s jump in and create 
our project...

Moving from page to page in InDesign
Since InDesign is a publishing application, it’s quite different from 
using a word processor.  If you’ve created a 12 page document, for 
example, you can move from page to page in a number of ways...

Of course, the most obvious way is to use the scroll bars.  You’ll see 
each page and its pasteboard area.

The next way is to use the Pages palette.  You can double-click any 
page’s thumbnail icon to go to that page in the document.  Also, 
you can re-order pages by drag-
ging them up or down the list.  
This is also where you can view 
the master pages (at the top of 
the dialog - usually begins with 
A-name or B-name, etc.).  You put 
items you want to appear on every 
page on the master page, like page 
numbering.

You can also use the page controls 
at the bottom of the screen to 
move to any page.  (See illustra-
tions at right and below.)

http://www.InDesignsecrets.com/change-measurement-systems-on-the-fly.php
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Working with Text in InDesign
There are two ways to enter text into inDesign.  One way is to type 
your document into your favorite word processing program.  Then 
you place the file into inDesign using the Place command (in the 
FILE menu).  InDesign generally imports all formatting information 
specified in the word-processing application, except information 
for word-processing features not available in InDesign. 

When you place a text document into 
inDesign, the cursor changes to a “place” 
cursor .  The cursor looks like the one to 
the right.  You’ll also see a little of the 
text you are placing (or picture, if it is a 
graphic).  Because you can place more 
than one file at a time in InDesign CS3, 
this becomes very handy - you can see 
which document you’re placing.  To place 
a document, you click in the upper left corner of the area in the 
document where you want to place the file, then drag to the lower 
right corner.

If there is more text than can fit in the frame you’ve cre-
ated, you’ll see a red plus in the lower right portion of the 
frame.  To place the remainder of the text somewhere 
else, get your selection tool (the shortcut is the escape 
key), click on the red plus, and your cursor changes into 
a place cursor again.  Move to another section of your 
document, click and drag another text frame, and your 
text will continue in this frame.  You keep doing this pro-
cedure until all your text is visible.

This kind of procedure results in a threaded story.  When you 
decide the change the shape or size of any of these text frames, the 
story will re-flow to fit the new area.  If any of your text cannot fit 
into the re-sized frames, then you’ll see the red plus sign again.

The other way you can enter text into inDesign is to type it directly 
in inDesign.  Grab your text tool and click and drag a text frame 
with it in your document.  The options bar at the top will change 
so you can see your font and size fields, and more ways to change 
and control your text than you ever had in your word proces-
sor.  You can see that option bar at the top of this page.  You can 
also use the Character palette in your 
palette area to control many of the font 
and type settings.  (See the Character 
palette to the right)

There’s much more about working with 
text in InDesign that we can’t cover in 
this short article.  Here are some other 
resources you may find helpful.

Link: http://www.layersmagazine.com/category/inde-
sign/

Link: http://www.adobe.com/designcenter/video_work-
shop/

Link:  http://indesignsecrets.com/

Link: http://www.pixel2life.com/tutorials/adobe_inde-
sign/

Adding Graphics into Your InDesign Document
One great thing about working with the Adobe CS3 suite of ap-
plications is they work very well together.  I use Bridge to view 
and scan through my document files, graphics, etc.  You can open 
a graphic in Photoshop CS3 and manipulate it the way you want, 
then save and open it within InDesign.  In InDesign, you can right-
mouse-button click on a graphic and choose ‘Edit Original,’ work 
with it in Photoshop, save the changes, jump back into InDesign, 
and the changes will be showing there.

You place a graphic the same way you 
place text.  You go to the FILE menu 
and choose the Place command.  
Select the image you want to place, 
and the cursor will change to the place 
cursor with a preview of your graphic 
showing.  Click and drag a frame, just 
like you did with text.

Depending on the size of your graphic you’re placing, you may not 
see all of the image in the frame you’ve created.  With the selection 
tool, you can click on the frame to see the re-size handles.  With 
the blue frame handles you can stretch or shrink the frame to see 
more (or less) of your image.  This re-sizes the frame only, not the 
graphic.

To re-size the graphic itself keep clicking the frame again with the 
selection tool until it turns brown.  Or you can grab the Direct Se-
lection tool (the white arrow tool) and click on the frame.  Now you 
can re-size the image rather than the frame.

Between these two tools, you can work with the size, cropping, 
and shape of both the frame and the image that has been placed 
within it.

To make your text wrap around your image, go to the Window 
menu and choose ‘Text Wrap.’  If you’ve used text wrap in Microsoft 
Word or other programs, this window will look familiar to you.  You 
can choose how your text will wrap around your graphic, as well as 
the spacing you want to separate your graphic from your text.  You 
have some options as well.  I use the text wrap window so much 
that I’ve dragged its window into my palette area so its always eas-
ily opened.

http://www.layersmagazine.com/category/indesign/
http://www.adobe.com/designcenter/video_workshop/
http://indesignsecrets.com/
http://www.pixel2life.com/tutorials/adobe_indesign/
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Using InDesign Master Pages
When you first create a new document, a default master page, 
called the A-Master, appears in the top section of the Pages palette.  
You can use this as your first master page, but you can also create 
as many master pages as you want in InDesign.  A master page is 
used to place graphics and text that are common to more than 
one page in your document.  For example, the color bar at the top 
and bottom of the UCET newsletters, and the page numbering 
are elements I’ve placed on the A-Master in this document.  Other 
common master page elements would be company logos, colored 
side bars, dividing bars, etc.  Remember, this is where you put 
something that you want to appear on many pages, so a master 
can save you lots of time!

To get to the master pages, or to create more of your own, go to 
the Pages palette in your palette bar.  Double click on the A-Master 
(which I renamed A-Front Page in the illustration at right.)  Then 
place text and graphics just as I described how on the previous 
page.

To create a new master, click on the small single triangle in the 
master page section of the Pages palette.  You’ll see the drop down 
menu at the right.  Choose ‘New Master...’ and follow the dialog box 
that will continue through the process.  Here you can also associate 
pages to a particular master page you’ve created (‘Apply Master to 
Pages...’), and you can load a master page from another document 
you’ve created.

To automatically number pages from a master page, get your text 
tool and create a text frame, then go to the Type menu, Insert 
Special Character, Markers, and choose ‘Current Page Number.’  Size 
and place this text frame on your master where you wish the page 
numbers to appear.  If you already have more than one master, 
you’ll want to copy this text frame and place it in the same position 
on your other masters as well. 

One nice thing about master pages in InDesign - you can create a 
new master page based upon one you’ve already created.  When 
you’re in a master page, the ‘Duplicate Spread’ option you see in 
the menu at right becomes ‘Duplicate Master Spread “A-Master”’ 
which will give you an exact copy of your master page, named 
‘B-Master’.  You can then change elements on that master page and 
associate pages with it.

Master pages are a very powerful and time saving feature of InDe-
sign.  If you do a daily, weekly, or monthly publication - and want 
to keep the same look and feel each time, you develop a document 
with all your text styles, master pages, and layouts, and save them 
as a template rather than a regular InDesign document.  That way, 
when you double click on a template file, InDesign will open a copy 
of your template, so you never end up writing to your template file.
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Creating a Table in InDesign
Tables are important to any text and layout application.  They are 
an easy way to communicate information quickly, and are often 
used to summarize large amounts of data into an easily read for-
mat.  Tables consist of rectangles (called cells) laid out in rows and 
columns.

InDesign regards tables as text, so they can only be created within 
a text frame.  And you’ll need the text tool to edit a table.  

To create a table, you must first create a text frame.  Grab your text 
tool and click and drag a text frame on your document.  Then you 
can go to the table menu and select ‘Insert Table...’  

In the dialog that appears (see illustration at right), you can choose 
how many rows and columns you desire.  You can also select how 
many header and footer rows you want.  A header row will appear 
at the top of the table, and if the table takes up more than one 
page - will appear at the top of the table on each page.  Of course, 
a footer row is the same, only at the bottom row of a table.

Once your table has been created, the ‘Table’ menu will allow you 
to control almost every aspect of your table, including the ability 
to merge cells together, or to unmerge them.  You can split cells 
either vertically or horizontally.  There’s a lot more you can do as 
well.  Explore the table menu options.

Adding color to a table always can put some pizzazz into a docu-
ment.  You use 
the text tool 
to select cells, 
rows, or columns 
of your table.  
Then go to the 
swatches palette to add a fill color or apply 
a stroke color.  In the upper 
left corner of the ‘Swatches’ 
palette, you’ll see the stroke 
and fill icon.  The stroke icon 
is on the bottom right, the 
fill icon is in the upper left 
in this illustration.  You can 
switch them by clicking the 
corner arrow.  Whichever icon is on top will 
be the active choicse.  If you want to fill the 
cells with color, make sure the fill icon is on 
top, then pick a color swatch from the list.  If 
the color you want is not in the list, create a 
new swatch by clicking the single triangle 
in the upper right corner of the palette, and 
choose ‘New Color Swatch.’  To color the lines of the table, switch to 
the stroke icon and follow the same procedure.

By the way, this is how you can color or put a stroke on any frame 
you’ve created in InDesign, including text and graphics frames.  
This is how you’d create a colored side bar box as well.  If you cre-
ate a shape with the Rectangle tool, elipse tool, or shape tool - this 
is how you’d color the fill and stroke on these as well.  You’ll notice 
that there is a ‘Stroke’ palette as well, which will let you choose the 
thickness and style of a stroke.  There is also a ‘Table’ palette which 
provides a quick click to many options you’ll find in the Table 
menu.
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A Typical Workflow for an InDesign Document...
It always helps to know the process for creating an InDesign docu-
ment.  Here the workflow I use...

1)  Create and name a folder for my InDesign project on my com-
puter’s hard drive.

2)  Create or gather all the text files (such as Word documents, 
Excel files, PDF documents, etc.) and graphics I plan on using in my 
InDesign document.

3)  Create a blank InDesign document and save it to my folder.

4)  Use the frame tool and create my layout for my document, 
including any master page layout items.

5)  Place (File-Place command) the text and graphics into the docu-
ment where I want them to be.  One of the great new features of 
InDesign CS3 is that you can select many documents or graphics to 
place at one time.  In the browse dialog that comes up when you 
issue a place command, you can select more than one file by using 
the shift key or the control key (command key on a Mac).  As you 
place files into frames in your document, you’ll see a preview of 
your file at the cursor.

6)  Clean up (perfection counts!), spell check, and otherwise double 
check that everything is working the way you want it to.  Be sure to 
save your file often.  Sometimes it’s helpful to save versions of your 
file as you go along.

7) Publish or print your file.  More about this...

Publishing Your InDesign Document
If you’re going to print your document, it’s as easy as File-Print in 
the menu.  Most print shops have InDesign, so if you’re printing 
things professionally, you can send your InDesign file to them to 
print.  Be sure to ask your publisher.

You can go to the File menu and do ‘Export’.  Here you can export 
your InDesign file as a PDF file, JPG image, EPS file, and more.  This 
is how I publish the UCET newsletter each month.

Conclusion
InDesign is a powerful desktop publishing program.  However, 
there are many others as well.  You’ll find many similarities between 
the various desktop publishing programs, so if you learn how to do 
one, it will be easier to learn others.  

Some desktop publishing programs are freeware.  One example is 
PagePlus SE from Serif.  PagePlus SE is a one way to get into desk-
top publishing and easily design professional-looking documents 
for every occasion.  

Link:  http://www.freeserifsoftware.com/

Link:  http://www.download.com/PagePlus-SE/3000-6675_4-10409484.html?cdlPid=10409485

If you’ve not used desktop publishing software before, you’ll be 
amazed at the freedom you have to easily arrange and place 
graphics, text, hyperlinks, and multimedia into a document.  You’ll 
start to wonder why you ever use that word processing program.  
Now, all I need is a computer that’s smart enough to write it all for 
me!  Or at least, let me tell it what to write....

http://www.freeserifsoftware.com/
http://www.download.com/PagePlus-SE/3000-6675_4-10409484.html?cdlPid=10409485



